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A Bit about DEEP VIEW 

The following program (DEEP VIEW version 3.7, formally called SWISS-PDB 
VIEWER) is used to translate a PDB file containing detailed molecular structure 
information into a picture. The PDB files from published structures (from both nuclear 
magnetic resonance spectroscopy and x-ray crystallography) are available at the 
Brookhaven Protein Data Bank http://www.rcsb.org/pdb/index.html. 

This shareware free software is a more robust visualization program than RASMOL and 
is commonly used by many structural biologists. Although the rendering is not as nice as 
in RASMOL, it provides a number of powerful tools for displaying and manipulating 
macromolecular structure that RASMOL can not. The user can display multiple 
structures, display electron density or electrostatic maps, display crystal symmetry (useful 
for displaying an entire molecule), create 'mutants', perform sequence alignments, 
superimpose related molecules, perform energy minimization's, and so on. If you are 
interested in structural biology research, you should learn how to use this program 
thoroughly. For more information on what DEEP VIEW can do, please see the 
introduction to Gale Rhodes tutorial as well as the ExPASy (Expert Protein Analysis 
System) Molecular Biology Server. Both web addresses can be found below.  

DEEP VIEW as an Analytical Tool. 

• Build models from scratch 
• Find H-bonds within proteins and between proteins and ligands 
• Examine e-density maps from crystallographic structure determination 
• Judge quality of maps and models 
• View several proteins simultaneously 
• Superimpose structures to compare structure and sequence 
• Carry out energy minimization 
• Creates homology models with SWISS-MODEL 

Computing Platforms for running DEEP VIEW. DEEP VIEW runs best on a 
Macintosh PowerPC, a UNIX computer (e.g. an SGI), or a Pentium based computer 
running Windows or NT. Other computers can be used but tend to be slow. In addition to 
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the computers available for this course, suitable computers can be found in the CCIT 
computing labs and the Biology Learning Center.  

• CCIT http://www.ccit.arizona.edu  
• Biology Learning Center (BLC) http://www.blc.arizona.edu  

Downloading DEEP VIEW and PDB files. To run DEEP VIEW, you must obtain the 
program DEEP VIEW 3.7 (already downloaded on the Biochemistry Lab computers), 
and a Protein Data Bank (PDB) file (which contains the coordinates for the structure to 
be viewed). 

• DEEP VIEW Umbrella Page (ExPASy) 
http://www.expasy.ch/spdbv/mainpage.html 

• Download DEEP VIEW version 3.7 http://us.expasy.org/spdbv/text/disclaim.htm  
• Download PDB files (PDB site) http://www.rcsb.org/pdb/  

DEEP VIEW User Guide and Help  

• User Guide http://us.expasy.org/spdbv/text/main.htm 
• Help directions http://www.usm.maine.edu/%7Erhodes/0Help/GetSPdbV.html) 

Additional DEEP VIEW Tutorials 

• Gale Rhodes (U. Southern Maine) 
http://www.usm.maine.edu/~rhodes/SPVTut/index.html (MOST 
RECOMMENDED!) 

• From DEEP VIEW Homepage (Expasy) 
http://us.expasy.org/spdbv/text/tutorial.htm 

• U. Arizona - formally used in Graduate course 585: Biological Structure 
http://www.biochem.arizona.edu/classes/bioc585/protnuc/example/example.htm 

 

Tutorial Exercise 

This exercise is designed to teach you the basics of molecular graphics display using the 
program DEEP VIEW. If you have any questions, please ask! We will be using the 
enzyme lysozyme in complex with the trisaccharide inhibitor tri-(N-acetylglucosamine) 
or tri-NAG. Atomic coordinates contained in the Protein Data Bank have a pdb code of 
1HEW.pdb.  

Tutorial Exercise Objectives:  

• Start and download structures into DEEP VIEW 
• Understand the Windows of DEEP VIEW 
• Become familiar with the Control Panel 
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• Become familiar with the Tool Bar 
• Practice keyboard modifiers 

Part I. Getting Started and Knowing the Various Windows of DEEP 
VIEW  

• Creating a DEEP VIEW folder  
• Obtaining the PDB file 1HEW.pdb  
• Starting DEEP VIEW  
• Opening a PDB structure  
• Opening Various Windows (Control Panel, Alignment, Layers Infos, 

Ramachandran Plot)  

• Create a DEEP VIEW folder in your directory. 
Unlike RASMOL, you do not need to save everything dealing with DEEP 
VIEW in this folder to have the program work properly. However, for 
organizational purposes, I highly suggest that you keep everything dealing 
with DEEP VIEW in this folder. 

• Obtain the PDB file 1HEW.pdb. (This can be done 1 of 2 ways:)  
1. On the course website under Computer Section/Shared PDB's and 

RASMOL Scripts.  
2. Go to the PDB and retrieve the coordinate file for lysozyme in complex 

with tri-NAG that has the name 1HEW. 

• Start DEEP VIEW. Double click on the DEEP VIEW icon on your desktop. A 
window that has credits will pop up Close this window. You will now see a 
window with menu pull downs as well as picture icons. This is called the Tool 
Bar and will be referred to as such from this point on. 

• Opening a PDB structure. Go to the 'File' pulldown menu at the top of the Tool 
Bar window. Scroll to 'Open PDB File...'. Scroll to your Deep View folder and 
open 1HEW.pdb. The protein should appear as a wireframe model in a black 
window, which is labeled with the name of the PDB file. This is called the in the 
Display window and will be referred to as such from this point on. Note: Unlike 
RASMOL, DEEP VIEW displays only in wireframe. In addition a window called 
inputlog.txt opens...don't worry about this, thus close it.  

• 'Window' pulldown Menu 
Go to the 'Window' pulldown menu at the top of the Tool Bar window. Scroll 
to the following to see its location and what each entails:  

o Control Panel. Opens to the right of the Display window. The Control 
Panel is very important. It lists the amino-acids residues and other contents 
of the PDB file. From here you select residues, label residues, color 
residues, ect. We will go into more depth in Part III of this tutorial, thus do 
not close this window. 
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o Alignment. Opens below the Display window. This window shows the 
amino acid sequence of the protein in one-letter abbreviations. This 
window comes in handy when comparing sequences of two or more 
proteins. For now, close this window. 

o Layers Infos. Opens to the right above the Control Panel. This table 
allows control of multiple protein models when needed. You can choose 
which model is visible, which model can move, and which model has 
certain features displayed. For now, close this window.  

o Ramachandran Plot. Opens to the left of the Control Panel. As learned in 
lecture, a Ramachandran plot allows you to judge the quality of a model 
and find residues whose conformational angles lie outside allowed ranges. 
For now, close this window. 

PART II. Moving your Model. 

To make your model active, click on the Display window. The following Tool Bar 
buttons will manipulate your model. Take time to play with these tools. More to come on 
the Tool Bar in PART IV. 

Tool Bar Buttons (First 4 buttons starting from left to right): 

•       Zoom/Center (arrows pointing in toward a residue): This 
automatically zooms to fill the screen with whatever is currently on 
display. Use this function when ever a view becomes awkward 

•       Translate (hand): This translates your model when you click and 
move your mouse over your model. 

•       Zoom (boxes): This zooms your model. 

•       Rotate (circular arrow): This rotates your model. 

• Tip: Pressing 'TAB': Cycles through the translate, zoom and rotate functions 
from left to right.  

o Pressing 'SHIFT + TAB': Cycles through the translate, zoom and rotate 
functions from right to left. 

PART III. The Control Panel. 

The control Panel is very important. It lists all the groups in your model and lets you 
select, display or hide parts of the model. It may seem overwhelming at first, but as with 
RASMOL, the more you play, the easier it will all come. 

Raw (i.e. Column) Headings (From Left to Right): 
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•       Far most left (which is blank in this case): When a protein 
contains more than one chain, the letter designation (Usually A & 
B) for each chain appears here. 

•       's' & 'h' (to the left of the 'group' column): secondary structure 
(sheet and helix respectively) 

•       'Group': lists the residue and hetero group names and numbers. 

•       'Show': displays the backbone of an individual or selected 
residues 

•       'Side': displays the sidechains of an individual or selected 
residues. 

•       'Labl': Labels individual or selected residues 

•       Dots: displays a dotted van der Waals or accessible surface of an 
individual or selected residues depending on which is activated. 

•       'Ribn': Stands for Ribbon; draws a smooth-stranded cartoon of the 
selected backbone 

•       'Col': Shows the color of each residue when colored. 

•       Far most right: Chooses what you want to color (ex. backbone + 
sidechains, backbone only, label, ect.) 

Tips and keyboard modifiers: 

When click on a group name: 

•       SHIFT: acts (meaning selects/deselects) on all groups. 

•       CTRL: acts only on selection without affecting other groups. 

•       SHIFT + CTRL: deselects  

•       Right Click: centers a group or select groups belonging to the 
same secondary structure 

•       In general, to select a group of residues in a row:  

o      Click and drag on those residues in the 'group' column 
OR  
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o      Click on the first residue and 'SHIFT + Click' on the last 
residue of interest. 

When click on a checkmark raw: 

•       In general, clicking in the checkmark raws next to a group acts 
on individual residues/groups. 

•       In general, clicking on a heading at the top of the raw acts on all 
selected (i.e. red) residues. 

•       SHIFT: acts (meaning checks/unchecked) on the whole raw 

•       SHIFT + CTRL: acts on the whole raw of each layer 

Additional: 

•       'Enter': adds selected groups and removes unselected groups.  

•       '+' on the numeric key pad: Toggles on and off the selected 
groups without affecting the other (unselected) groups. Make sure 
you NUMBER LOCK IS ON!!!  

-------------------------------------------------------- 

Exercise: Now Let's play with these a bit: 

• First, scroll down to the bottom to see how many amino acids and the names of 
the hetero group(s) the protein contains. Hetero group(s) are always listed last. 

• Select LEU 25- SER 36: Click and drag on the word LEU 25 through SER 36. 
These residues are now selected and should turn red.  

• Press 'Enter'. Notice only those residues selected (residues 25-36) remain in the 
display window and have a check next to them in the 'show' and 'side' raws. Move 
the display using the manipulation tools learned previously. What type of 
secondary structure is this?  

*Note: When using the Control Panel, a sidechain is only 
shown if the residue is displayed. You can display only the 
sidechains without the backbone by using the 'Show 
Sidechains even when Backbone is Hidden' under the 
'Display' pulldown in the Tool Bar. 

• Click the checkmark in the 'show' raw next to CYS 30. Notice that CYS 30 
disappears. Click in the same space to make it reappear. Try the same in the 
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'side', 'label', and 'surface' raws and see what happens. Now remove the checks 
from the 'label' and 'surface' raws simply by clicking on the checkmark. 

• Click on the raw heading word 'label'. Notice all selected residues are now 
labeled. 

• Click on the raw heading picture of 'dots'. This shows a dotted van der walls or 
accessible surface on all selected residues depending on which is activated. 

• Click on the raw heading word 'ribn'. This draws a smooth-stranded cartoon of 
the selected backbone. 

• Remove all labels, surface and ribbon. Try both of these ways:  
o 'SHIFT + Click' simultaneously on a checkmark in the respective raw 

OR 
o 'CTRL + SHIFT + Click on the raw heading 

  

*Note: To add all labels, surface and ribbon again simply use the 
above in an empty space in the respective raw. 

• Add, but not select, residues 16-24 to your model. Click from residue 16-24 in 
the 'show' raw . Notice checks appear, however they do not turn red. This means 
that residues 25-36 are selected and shown, while residues 16-24 are shown, but 
NOT selected. 

• Press '+' on the numeric key pad. This toggles on and off the selected groups 
without affecting the other groups. End with residues 16-36 displayed. 

• Press Enter. Notice that residues 16-24 disappear because they were not selected 
. 

• Select and display residues 13 and 19 in addition to what is already selected.  
o 'CTRL + Click' on residues 13 and 19 in the 'group' raw. They should 

turn red.  
o Press 'Enter' to add them to the display.  
o Click on the raw heading 'side' to turn on their sidechains . 

  

• Click anywhere in the far most left, blank raw. Notice the entire chain (in this 
case, the entire model) has been selected and thus turns red. Press 'Enter' to 
display the chain. 

• Click on any 'h' in the second column. This selects all residues in that helix. 
Press 'Enter' to display the helix.  

• Click on another 'h' or 's'. This changes your selection. Press 'Enter' to display. 
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PART IV. The Tool Bar. 

The Tool Bar allows you to perform a variety of actions. We will not be able to go 
through all the icons or pulldown menus today so I suggest playing on your own. Instead 
we will have a brief overview of the icons not mentioned in PART II and of some of the 
more basic and/or useful operations in the pulldown menus. 

Buttons (From Left to Right): To use, simply click on the button and follow the 
directions which appear below it in red. 

•       Zoom/Center (arrows pointing in toward a residue): This 
automatically zooms to fill the screen with whatever is currently on 
display. Use this function when ever a view becomes awkward 

Manipulative: 

•       Translate (hand): This translates your model when you click and 
move your mouse over your model. 

•       Zoom (boxes): This zooms your model. 

•       Rotate (circular arrow): This rotates your model. 

Most Commonly Used Tools: 

•       Distance between two atoms 

•       Angle between three atoms 

•       Dihedral angles (By default, gives a measure of omega, phi and 
psi angles of the picked amino-acid) 

•       Atom Identification 

•       Display/Undisplay selected groups in a certain radius 

•       Center the molecule on one atom 

•       Fit a molecule onto an other (More advanced fitting features 
available in the 'Tools' pulldown) 

•       Mutation tool 

•       Torsion tool (Allows to rotate sidechains atoms) 
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Menu Pull-downs 

• File - Commands as most programs. 
• Edit - Commands as most programs. 
• Select - Provides commands for selection in addition to those in the Control Panel  

o all: selects all 
o inverse: selects opposite of what is selected 
o visible: selects those residues that are currently visible 
o pick on screen: selects those which you click on in the display 
o group kind: selects by amino acid, nucleic acid, heteroatom, solvent or 

disulfide bonds 
o group property: selects based on acidity or polarity 
o secondary structure: selects alpha helices, beta sheets or coiled 
o accessible aa: selects amino acids over a certain accessible cut off 

(determined by user) 
• Build - Useful when rebuilding a model during a process called refinement. For 

now, don't worry about this menu. 
• Tools - Provides various advanced tools, some of which we will discuss in later 

lessons. 
• Fit - Allows various operations such as superimposition of molecules. This 

pulldown will only be active when more than one molecule is present. 
• Display - Allows options on different ways to display molecule. The most 

important are:  
o Show CA trace only 
o Show sidechains even when backbone hidden (command noted in 

PART III) 
• Color - Provides many different ways to color a model. Color is not trivial. It can 

reveal structural, chemical and comparative features. It is to note that the same 
operations in this menu can also be done through the Control Panel (i.e. the last 
two raws to far right)  

o 1st: Choose an 'act on...' (BB & SC, BB only, ect.)  
� Backbone + Sidechains 
� Backbone 
� Sidechains 
� Ribbon 
� Label  
� Surface 

o 2nd: Choose a 'by...'  
� CPK: carbon = gray, nitrogen = blue, oxygen = red 
� Type: basic (+) = blue, acidic (-) = red, nonpolar = gray, yellow = 

polar, uncharged 
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*Note: aromatics are included into one of 
the above categories. (Ex. Tyr is yellow, 
thus polar and uncharged) 

•       Secondary Structure: alpha-helices = red, beta-
sheets = blue, coil = gray 

•       Accessibility: The darker the color, the less 
accessible to solvent 

• Preferences - Sets how you want to the program to perform. In other words, you 
can customize tools to your liking. I suggest not changing anything for this class 
and use the programs default preferences. 

• Swiss-Model - Creates homology models. This is beyond the scope of this class, 
thus ignore this menu. 

• Window - Please see PART I for details. 
• Help - Provides help files for the Tool Bar, Control Panel, Layer Info, Alignment, 

and Ramachandran Plot Windows. (Note: These help files can also be found by 
clicking the red '?' in each window.) Also provided here is a web or local-based 
copy of the user manual. 

-------------------------------------------------------- 

Exercise: Now Let's play with these a bit. Since many of the menus and buttons are 
relatively intuitive, there will be less guidance on getting the end result and more 
questions asked. Please put answers on a separate piece of paper: you will be asked 
to hand these in the Wednesday after the exam. 

We will concentrate on the Select, Display and Color pulldown menus first. 

1. Select and display the whole molecule and color it CPK: Go to the 'Select' 
pulldown menu, then to 'all'. To display residues, press 'Enter'.  

o Again, what were the steps you used to accomplish this? 
2. Select and display accessible residues with a cut off of 30: Go to the 'Select' 

pulldown menu, then to 'accessible aa...'. Enter a cut off of 30 and then press 'OK'. 
To display only these residues, press 'Enter'.  

o Where are most of these residues located? (Hint: color by accessibility) 
o What type of residues are they? (Hint: color by type) 
o Name two of these residues. 

3. Select and display all residues involved in beta-strands. Notice the characteristic 
pattern of hydrogen bonds in the strands. (Note: To turn on H-bonds, go to the 
'Tools' menu pulldown and then choose 'Compute H-bonds'. To turn off H-bonds, 
go to the 'Display' menu pulldown and then uncheck 'Show H-bonds'.)  

o How many strands are shown? 
o Are they close in the primary amino acid sequence? 
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4. Select and display only the residues whose sidechains carry positive charge (i.e.. 
basic residues).  

o Where are these residues located? 
o What color are they? 
o Name two of these residues. 

5. Select and display only the histidine residues and their side chains.  
o How many histidines are present in lysozyme? 
o When colored by type, what color are histidines? 

6. How many disulfide bonds are present in this model? What are the residue names 
and numbers involved in these disulfide bonds? 

7. What is the approximate length of a disulfide bond? 
8. What is the approximate length of a hydrogen bond? (Hint: you first have to 

'Compute H-bonds' from the 'Tools' menu pulldown then measure the distance). 
9. Name two residues within 6A of the heteroatom NAG.  

  

Extra Problem:  

10. Make a model in which lysozyme is shown only as a ribbon, colored by secondary 
structure, and tri-NAG is shown in normal (CPK) colors with a dotted van der Waals 
surface.  

•       What are the steps you used to accomplish this view? 

 


